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Careers Home/Candidate Gateway 
Frequently Asked Questions (FAQ’S) 

 

 

We have recently implemented a new careers site for certain HHC 
facilities. Additional HHC facility employment opportunities will also be 
available on the new careers site on an ongoing basis.  

Due to the large number of applications that we receive for each job 
opening, HHC cannot personally respond to each inquiry. 
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Purpose:  Below is a list of questions applicants frequently have during and after submitting an online application. 
This information will explain a variety of things, including what to expect after submitting an application and how 
to apply for additional positions. 

 
Frequently Asked Questions: 

Logging on to the Careers Home Application 

Q: Does HHC accept paper applications? 

A: Yes. Paper applications and resumes will still be accepted at all facilities. Please follow the 
instructions on the job posting to submit your paper resume via fax or in-person. 

Q: How do I find out what jobs are available? 

A:   From the Careers Home Page, enter basic job search information into the search box and 
confirm the timeframe/date range for the search. Applicable job postings then appear on the 
page and you can select a posting title to review. Additionally, the most recent job postings 
are posted in the Latest Postings section.  

    Q: What if someone does not have access to a computer or the web? 

A:   Paper resumes and/or applications will be accepted from those applicants who do not have 
access to a computer or the internet. Please visit the facility Human Resources department in 
person to drop off your resume and other documentation, or make arrangements to send this 
information to them.  Please note the job opening ID of the position(s) you are interested in 
when submitting your information. 

Q: Can I apply for more than one job at time?  

A:  Yes. Click on the next desired Job Title link or job posting check box and click the Apply Now 
button. 

Q: If I’m not sure which job I want, can I just submit a blank application online and let HHC 
determine the job for which I am most qualified?  

A: No. To be considered as an applicant at HHC, you must formally apply for a position. 

Q: Are all sections of the online application required? 

A: Yes. 

Q: I applied for a job yesterday. I found another job online that I want to apply for today. Do I 
have to fill out all my information again?   

      A: Yes, but you must first apply for every job you are interested in and the saved information 
will default in. While logged on, Careers Home will then retrieve your profile. Careers Home 
will “remember” some of the information you have already provided. Currently, this includes 



 

Last Updated: 8/24/09 3 of 7                                NYC HHC Online Applicant FAQs  

 

any data you have input on your profile, including preferences, education, work experience, 
references and language pages. Please verify that the pre-populated information is accurate.  

Q: Do I have a time limit on how long I can spend on each section of the application? 

A:  No. There are no time limits while you are actively using the system to create and submit an 
application. However, to protect the security of your data, the system will time out and log you out 
after 20 minutes of inactivity. If you are unable to finish your application, you may click the “Save 
for Later” button to continue the application at a later time, as long as the position is still available. 

Q: How do I know that you have received my application? 

A: Once you submit your application, you will receive a confirmation email, if you have provided a 
valid email address. You may also check “My Applications” to view your status through the 
“My Profile” link. 

Q: What if my files are not Microsoft Word, Adobe Acrobat (.pdf) or rich text format (.rtf) 
documents?  

A: At this time, our online system can only accept documents created with Microsoft Word or 
Adobe .pdf, or rich text format .rtf. You will need to convert your documents before attaching 
them to your application.  

Q: How can I save my job searches? 

A: Job search agents are created by accessing the advanced search page, entering search 
criteria relevant to the position(s) you seek and then save the criteria. Applicants will be 
notified periodically about any new positions matching their job search agent(s), provided that 
their e-mail address is correct. 

   Q: I am having a problem using the Back button to get to a prior page. It keeps returning me    
to the same page, what do I do? 

A: Do not use your browser's "back," "forward" or "refresh" buttons to navigate the online 
careers site. This may cause unexpected results, including loss of data or being logged out of 
the system. Please use only the navigational buttons within the site.  

Q: I am having a technical problem with my computer that is stopping me from completing the 
application or applying for a job. What can I do? 

A: Follow these instructions to delete your cookies:  
 
Internet Explorer 6.0 for Windows 
1. On the Tools menu, click Internet Options, and then click the General tab. 
2. In the Temporary Internet Files section, click Delete Cookies, click OK, and then click OK 
again.  
 
Internet Explorer 5.x for Windows 
1. On the Tools menu, click Internet Options, and then click the General tab. 
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2. Under Temporary Internet Files, click Settings. 
3. Click View Files. 
4. On the View menu, click to select the Details command. 
5. Highlight them all at once and then either: drag them to the Recycle Bin, press the Delete 
key, or right-click the files and select Delete. 

If you have additional issues, please contact the appropriate HHC facility Human Resources 
Office. 

Q: Which browser(s) can I use to apply for jobs through the Careers Home site? 

A: Internet Explorer, Mozilla Firefox and Safari are the recommended browsers to use when 
applying online. 

 
 

FAQs for Employees 

Q: What if I do not have a PeopleSoft ID or password? 

A: If you are working in a facility using PeopleSoft and you do not have a PeopleSoft ID or 
password, you may apply as an external applicant. Also, you should contact your Manager or 
facility IT department, as appropriate, and work with them to obtain a network user ID and 
password. 

Q: As an HHC employee, how do I update my personal information? 

A: Employees must change their information by placing a request through their facility Human 
Resources department.  

FAQs for External Applicants 

 Q: What if I have forgotten my User ID and/or password? 

A: Click on Login Help link located within the log-in section. 

If you forget your user name, and as long as you know your email address (if you entered a 
valid one when you initially registered), your user name will be emailed to you.  To receive 
your password, you will need to know your user name.   

If you did not provide an email address and do not remember your user name, you will need to 
re-register as a new user.   

 Q: I have already created an online application and applied for positions. I am now returning 
to apply for additional jobs and receive a message saying “User Name already exists.”  
A: If you have already created an account and are a returning applicant, please go to the 

Careers Home Page, login to the system using your User Name and Password from your 
last visit.  
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    Q: As an external applicant, how can I modify my profile information? 

A: While logged into Careers Home, simply click on the My Profile link within My Career Tools 
to edit and save your online information. Your applicant record updates automatically once 
your information is saved. Please ensure that your contact information is updated regularly so 
we are able to contact you as needed. 

Q: I am a terminated, retired, or former HHC employee. What should I do? 

A: Apply as an external applicant and indicate this when asked in your application. 
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HHC Facility Human Resources/Recruiting Department Locations 

 

MANHATTAN 
 
HHC Central Office 
346 Broadway, Suite 711 
New York, NY 10013 
Phone: (212) 442-0352 
 
HHC Health & Home Care – Main Office 
160 Water Street, 9th Floor 
New York, NY 10038 
Phone: (646) 458-6193 
 
MetroPlus Health Plan 
160 Water Street, 4th Floor 
New York, NY 10038 
Phone: (212) 908-8600 
 
Bellevue Hospital Center 
462 First Avenue - Room A129 
New York, NY 10016 
Phone: (212) 562-6283 
 
Harlem Hospital Center 
16 West 137th Street (Women's Pavilion),6th Floor 
New York, NY 10037 
Phone: (212) 939-2593 

 

Renaissance Diagnostic & Treatment Center 
Apply @ Harlem Hospital Center: 
16 West 137th Street (Women's Pavilion),6th Floor 
New York, NY 10037 
Phone: (212) 939-2593 
 
Metropolitan Hospital Center 
1901 First Avenue Room 121A 
New York, NY  
Phone: (212) 423-6172 
 
Coler-Goldwater Specialty Hospital & Nursing Facility 
1 Main Street 
Roosevelt Island, NY 10044 
Phone: (212) 318-4465 
 
Gouverneur Healthcare Services 
Apply @ Coler-Goldwater Campus: 
1 Main Street 
Roosevelt Island, NY 10044 
Phone: (212) 318-4465 

 

BROOKLYN 

Kings County Hospital Center 
451 Clarkson Avenue Room T-125 
Brooklyn, NY 11203 
Phone: (718) 245-2022 
 
East NY Diagnostic & Treatment Center 
Apply @ Kings County Hospital Center: 
451 Clarkson Avenue Room T-125 
Brooklyn, NY 11203 
Phone: (718) 245-2022 
 
Dr. Susan Smith McKinney Nursing & Rehabilitation Center 
Apply @ Kings County Hospital Center: 
451 Clarkson Avenue Room T-125 
Brooklyn, NY 11203 
Phone: (718) 245-2022 
 
HHC Brooklyn Central Laundry 
645 Kingston Avenue, 2nd Floor 
Brooklyn, NY 11203 
Phone: (718) 245-2927 
 

 
Woodhull Medical Center 
760 Broadway - Room 3A140 
Brooklyn, NY 11206 
Phone: (718) 963-8132 
Note: Applications are accepted in person from: 9AM – 12PM 
Wednesdays thru Fridays 
 
Cumberland Diagnostic & Treatment Center 
Apply @ Woodhull Medical Center: 
760 Broadway - Room 3A140 
Brooklyn, NY 11206 
Phone: (718) 963-8132 
Note: Applications are accepted in person from: 9AM – 12PM 
Wednesdays thru Fridays 
 
Coney Island Hospital 
2601 Ocean Parkway, Building 6 
Brooklyn, NY 11235 
Phone: (718) 616-4826 

QUEENS 
 
Queens Hospital Center 
82-68 164th Street "T" Building, 6th Floor 
Jamaica, NY 11432 
Phone: (718) 883-4841 
 
 
 
 

 
Elmhurst Hospital Center 
Apply @ Queens Hospital Center: 
82-68 164th Street "T" Building, 6th Floor 
Jamaica, NY 11432 
Phone: (718) 883-4841 
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BRONX 
 
Jacobi Medical Center 
1400 Pelham Parkway South, Staff House Building, Room 101 
Bronx, NY 10461 
Phone: (718) 918-3520 
 
Jacobi Medical Center - Nurse Recruitment 
1400 Pelham Parkway South, Nurses’ Residence Building, 
Room 13N10 
Bronx, NY 10461 
Phone: (718) 918-7190 
 
North Central Bronx Hospital 
Apply @ Jacobi Medical Center: 
1400 Pelham Parkway South, Staff House Building, Room 101 
Bronx, NY 10461 
Phone: (718) 918-3520 
 
North Central Bronx Hospital - Nurse Recruitment 
Apply @ Jacobi Medical Center: 
1400 Pelham Parkway South, Nurses’ Residence Building, 
Room 13N10 
Bronx, NY 10461 
Phone: (718) 918-7190 
 
 

 
Lincoln Medical & Mental Health Center 
234 Eugenio Maria De Hostos Blvd (East 149th Street) 
2nd Floor, 2D2, Room 386 
Bronx, NY 10451 
Phone: (718) 579-6270 
 
Morrisania Diagnostic & Treatment Center 
Apply @ Lincoln Medical & Mental Health Center: 
234 Eugenio Maria De Hostos Blvd (East 149th Street) 
2nd Floor, 2D2, Room 386 
Bronx, NY 10451 
Phone: (718) 579-6270 
 
Segundo Ruiz Belvis Diagnostic & Treatment Center  
Apply @ Lincoln Medical & Mental Health Center: 
234 Eugenio Maria De Hostos Blvd (East 149th Street) 
2nd Floor, 2D2, Room 386 
Bronx, NY 10451 
Phone: (718) 579-6270 
 
 
 
 

STATEN ISLAND 
 
Sea View Hospital Rehabilitation Center & Home  
460 Brielle Avenue, Room ADM 101 
Staten Island, NY 10314 
Phone: (718) 317-3290 
 

 

Please remember to note the position(s) that you are interested in applying for when submitting your 
resume/application to our facilities.  

 

 


